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Introduction
Purchase Vouchers allows you to generate purchase vouchers for Accounts Payable 
invoices in accordance with the decree 522 issued by the Finance and Public Credit 
ministry. This voucher is generated for all open and historic invoices. This voucher 
is issued to those vendors who are not businesses, or to those who are registered 
under the simplified regime as specified by the tax authorities.

Check for current instructions
This information was current as of May 2010. The documentation may be updated 
as new information becomes available. Check the Microsoft Dynamics® GP online 
Web site (http://go.microsoft.com/fwlink/?LinkID=161199) for the most current 
documentation.

The introduction is divided into the following sections:

• What’s in this manual
• Symbols and conventions
• Resources available from the Help menu
• Send us your documentation comments

What’s in this manual

This manual is designed to give you an in-depth understanding of how to use the 
features of Purchase Vouchers, and how it integrates with the Microsoft Dynamics 
GP system.

To make best use of Purchase Vouchers, you should be familiar with systemwide 
features described in the System User’s Guide, the System Setup Guide, and the 
System Administrator’s Guide.

Some features described in the documentation are optional and can be purchased 
through your Microsoft Dynamics GP partner.

To view information about the release of Microsoft Dynamics GP that you’re using 
and which modules or features you are registered to use, choose Help >> About 
Microsoft Dynamics GP.

This manual is divided into the following chapters:

• Chapter 1, “Setup,” describes how to perform the necessary setup to use 
Purchase Vouchers.

• Chapter 2, “Routines,” explains how to assign the purchase voucher numbers, 
and how to print purchase vouchers.

http://go.microsoft.com/fwlink/?LinkID=161199
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Symbols and conventions

For definitions of unfamiliar terms, see the glossary in the manual or refer to the 
glossary in Help.

This manual uses the following conventions to refer to sections, navigation and 
other information.

Resources available from the Help menu

The Microsoft Dynamics GP Help menu gives you access to user assistance 
resources on your computer, as well as on the Web.

Contents
Opens the Help file for the active Microsoft Dynamics GP component, and displays 
the main “contents” topic. To browse a more detailed table of contents, click the 
Contents tab above the Help navigation pane. Items in the contents topic and tab 
are arranged by module. If the contents for the active component includes an 
“Additional Help files” topic, click the links to view separate Help files that 
describe additional components.

To find information in Help by using the index or full-text search, click the 
appropriate tab above the navigation pane, and type the keyword to find.

To save the link to a topic in the Help, select a topic and then select the Favorites 
tab. Click Add.

Index
Opens the Help file for the active Microsoft Dynamics GP component, with the 
Index tab active. To find information about a window that’s not currently displayed, 
type the name of the window, and click Display.

About this window
Displays overview information about the current window. To view related topics 
and descriptions of the fields, buttons, and menus for the window, choose the 
appropriate link in the topic. You also can press F1 to display Help about the 
current window.

Symbol Description

The light bulb symbol indicates helpful tips, shortcuts and 
suggestions.

The warning symbol indicates situations you should be 
especially aware of when completing tasks.

Convention Description

Creating a batch Italicized type indicates the name of a section or procedure.

File >> Print or File > 
Print

The (>>) or (>) symbol indicates a sequence of actions, such as 
selecting items from a menu or toolbar, or pressing buttons in 
a window. This example directs you to go to the File menu and 
choose Print.

TAB or ENTER All capital letters indicate a key or a key sequence.
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Lookup
Opens a lookup window, if a window that you are viewing has a lookup window. 
For example, if the Checkbook Maintenance window is open, you can choose this 
item to open the Checkbooks lookup window.

Show Required Fields
Highlights fields that are required to have entries. Required fields must contain 
information before you can save the record and close the window. You can change 
the font color and style used to highlight required fields. On the Microsoft 
Dynamics GP menu, choose User Preferences, and then choose Display.

Printable Manuals
Displays a list of manuals in Adobe Acrobat .pdf format, which you can print or 
view.

What’s New
Provides information about enhancements that were added to Microsoft Dynamics 
GP since the last major release.

Microsoft Dynamics GP Online
Opens a Web page that provides links to a variety of Web-based user assistance 
resources. Access to some items requires registration for a paid support plan.

Current implementation and upgrade information The most recent 
revisions of upgrade and implementation documentation, plus documentation 
for service packs and payroll tax updates.

User documentation and resources The most recent user guides, how-
to articles, and white papers for users.

Developer documentation and resources The most recent 
documentation and updated information for developers.

Product support information Information about the Microsoft Dynamics 
GP product support plans and options that are available, along with 
information about peer support and self-support resources.

Services information Information about Microsoft Dynamics GP support, 
training, and consulting services.

Microsoft Dynamics GP Community Access to newsgroups, where you 
can ask questions or share your expertise with other Microsoft Dynamics GP 
users.

CustomerSource home page A wide range of resources available to 
customers who are registered for a paid support plan. Includes access to 
Knowledge Base articles, software downloads, self-support, and much more.

Customer Feedback Options
Provides information about how you can join the Customer Experience 
Improvement Program to improve the quality, reliability, and performance of 
Microsoft® software and services.
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Send us your documentation comments

We welcome comments regarding the usefulness of the Microsoft Dynamics GP 
documentation. If you have specific suggestions or find any errors in this manual, 
send your comments by e-mail to the following address: bizdoc@microsoft.com.

To send comments about specific topics from within Help, click the Documentation 
Feedback link, which is located at the bottom of each Help topic.

Note: By offering any suggestions to Microsoft, you give Microsoft full permission to use 
them freely.

mailto:bizdoc@microsoft.com
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Chapter 1: Setup
Use this information to set up and begin using Purchase Vouchers. You must first 
classify the vendors before you can generate the purchase vouchers for payables 
invoices.

When you set up Purchase Vouchers, you can open each setup window and enter 
information, or you can use the Setup Checklist window (Microsoft Dynamics GP 
menu >> Tools >> Setup >> Setup Checklist) to guide you through the setup 
process. See your System Setup Guide (Help >> Contents >> select Setting up the 
System) for more information about the Setup Checklist window.

• Setting up purchase vouchers
• Understanding consecutive numbering

Setting up purchase vouchers

Use the Purchase Voucher Configuration window to identify the vendors who are 
registered under the simplified supplier regime. These vendors, as well as those that 
are not registered as businesses, will be issued purchase vouchers for each payables 
invoice. You must enter a starting number for the purchase vouchers. The purchase 
vouchers are numbered consecutively based on their posting date, starting from the 
number you assign here. Refer to Understanding consecutive numbering on page 6 for 
more information.

To set up purchase vouchers:
1. Open the Purchase Voucher Configuration window.

(Cards >> Purchasing >> Purchase Voucher)

The User field displays the user ID that you are logged in as.
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2. Enter the starting number up to 17 digits in the Next Number field. The 
purchase vouchers that you generate will be numbered consecutively starting 
from this number. Be sure to enter a number with adequate leading zeroes. This 
number is updated with the next available number each time you assign the 
voucher numbers. The Last Update field displays the date on which the 
purchase vouchers were last generated.

3. Select an option based on which to select the documents to print in the purchase 
vouchers, whether All Displayed Documents or Selected Documents.

All Displayed Documents Prints all the documents displayed in the 
Payables Transaction Inquiry – Document window. In this option, only the first 
page of each document contains the report header information.

Selected Document Prints the document selected in the Payables 
Transaction Inquiry – Document window. In this option, each page of each 
document contains the reports header information.

Refer to Generating and printing purchase vouchers on page 8 for more 
information.

4. Select a vendor ID to add to the Simplified Supplier Regime list. You can add as 
many vendors as are registered under this scheme.

You can also create a text file with the details of vendors that are registered as 
businesses, individuals, or under the simplified supplier regime. You can then use the 
Table Import tool (Microsoft Dynamics GP menu >> Tools >> Integrate >> Table 
Import) to import this information to the Purchase Voucher vendor master table. Refer 
to the Import Utility documentation for more information.

5. Choose OK to save the information you entered and close the window.

Understanding consecutive numbering

The purchase vouchers that are generated for payables invoices must be numbered 
consecutively based on their posting date. You can enter the starting number for this 
numbering sequence in the Next Number field of the Purchase Voucher 
Configuration window. This number is updated each time you generate purchase 
vouchers. You can enter up to 17 digits in this field. The number of purchase 
vouchers that can be generated depends on the number you enter here, so be sure to 
enter a number with adequate leading zeroes.

For example, if you enter 001 as the next number, you can generate purchase 
vouchers up to the number 999. The transaction after the number 999 will be 
assigned a purchase voucher number 000. No numbers will be assigned to 
transactions after this. However, if you choose Additional >> Generate Purchase 
Voucher, then any previously unassigned numbers in the range 001 to 999 will be 
assigned to the next documents. Once all the numbers in the range have been used, 
you cannot generate any more purchase vouchers.
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Chapter 2: Routines
Use this information to assign the purchase voucher number for all posted payables 
documents for the specified vendors. You can then print the purchase vouchers to 
be issued to the respective vendors.

This information is divided into the following sections:

• Assigning consecutive purchase voucher numbers
• Generating and printing purchase vouchers

Assigning consecutive purchase voucher numbers

You can assign purchase voucher numbers to your payables invoices from the 
Payables Transaction Inquiry - Document window. The numbers are assigned 
consecutively based on the document’s posting date. We recommend that you run 
this routine each time you post a document, in order to maintain the numbering 
sequence. Once a document is assigned a purchase voucher number, it will not 
change even if you re-run the process.

To assign consecutive purchase voucher numbers:
1. Open the Payables Transaction Inquiry - Document window.

(Inquiry >> Purchasing >> Transaction by Document)

2. Select the criterion to display documents in the scrolling window, by Document 
Number, Document Date, or Vendor ID. Select All or enter the range for the 
selected criterion.

3. Choose Redisplay to display the documents according to your selection. The 
purchase voucher numbers will be assigned only to the documents displayed in 
the scrolling window.

4. Choose Additional >> Assign Consecutive COC numbers to assign consecutive 
purchase voucher numbers to the payables documents based on their posting 
date. The starting purchase voucher number is the one specified in the Next 
Number field of the Purchase Voucher Setup window.

5. Choose OK to close the window.
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Generating and printing purchase vouchers

You can print the purchase vouchers once you have assigned consecutive purchase 
voucher numbers to posted payables documents. The purchase voucher contains 
details about each item listed in the purchase invoice, such as the unit of measure, 
quantity, unit price, and total value. You can generate the purchase vouchers for all 
the documents displayed in the window, or for a single selected document, based 
on your set up in the Purchase Voucher Configuration window. Refer to Setting up 
purchase vouchers on page 5 for more information on the contents of each type of 
report.

To print the purchase vouchers, go to Inquiry >> Purchasing >> Transaction by 
Document >> Print COC Document. The purchase vouchers are generated in two 
separate files for open and historic transactions respectively. If you have not 
assigned the consecutive purchase voucher numbers to a document, they are 
assigned automatically while printing the purchase vouchers. Refer to Assigning 
consecutive purchase voucher numbers on page 7 for more information.

If the next number that you have entered is 000, then the purchase voucher numbers will not 
be assigned automatically. You must run the Assign COC numbers process before printing 
the purchase vouchers.
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Glossary
Consecutive purchase voucher 
number

Consecutive numbers assigned to the 
purchase vouchers based on the posting 
date.
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